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Anahtar Teslim
Ameliyathane Projeleri

Turnkey Operating Room Projects
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* Luvis Ameliyat Lambasi
Luvis Operating Light

Luvis M200 Luvis M200

> 120.000 Lux. Isik Siddeti > 120.000 Lux. Light Intersity
> 3 Kademe Ayarlanabilir Renk Sicakligi > 3 Level Adjustable Color Temperature
> Dokunmatik Kontrol Paneli > Touchscreen Control Panel

> Opsiyonel HD Kamera Secenegi > Optional HD Camera Option

.‘-ﬁi FLELEL EI '

Wby
o ! A

o
L

Luvis L200
> 160.000 Lux. Isik Siddeti

> 3 Kademe Ayarlanabilir Renk Sicakligi
> Dokunmatik Kontrol Paneli

> Opsiyonel HD Kamera Secenegi

Luvis L200
> 16 0.000 Lux. Light Intersity

> 3 Level Adjustable Color Temperature

> Touchscreen Control Panel

> Optional HD Camera Option

4 uvis

05 |



SeaMed Ameliyat Masasi
SeaMed Operating Table

Genel Cerrahi, Uroloji, Jinekoloji, Ortopedi, Géz, Beyin Cerrahisi, KBB, Kardiyoloji vb. ____'/

Bircok Operasyon Kullanimina Uygun Olarak Tasarlanmistir. {

» Tim Cerrahi Operasyonlar Icin Pozisyonlandinilabilir
» El Kumandasi Yardimi ile Kolay Kullanim Imkani
> 300 Kilograma Kadar Hasta Tasima Kapasitesi
> Agisi Ayarlanabilir Ayak ve Bas Bolimu

> Opsiyonel Eklenebilir Ortopedi Traksiyon Seti

General Surgery, Urology, Gynecology, Orthopedics, Ophthalmology,
Neurosurgery, ENT, Cardiology etc. It is Designed For Many

Operation Uses.

> Can Be Positioned For All Surgical Operations
> Easy to Use With the Help Of Hand Control
> Patient Carrying Capacity Up to 300 Kilograms
> Angle Adjustable Foot and Head Section

> Optional Add-On Orthopedics Traction Set

SeaMed

06



S DENIZLER
e MEDIKAL
'SeaMed Anestezi Cihazi

SeaMed Anesthesia Device

> Yetiskin/Pediatrik/Yenidogan Hasta Gruplarinda Kullanim Imkani
> TFT-LCD Parametre Takip Monitéri

> Cift Vaparizator Kullanimi
> VCV, PCV, SIMV-PC, SIMV-VC, CPAP-PSV, AGCO ve
Manual Ventilasyon Modlar

> Opsiyonel EtCO2BIS, AG, O2 parametleri

> Possibility of Use in Adult / Pediatric / Neonatal Patient Groups
> TFT-LCD Parameter Monitor
> Use of Double Vaporizer

> VCV, PCV, SIMV-PC, SIMV-VC, CPAP-PSV, AGCO and
Manual Ventilation Modes

> Optional EtCO2, BIS, AG, O2 parameters

SeaMed Anestezi ve ilac Arabasi
SeaMed Anesthesia and Medicine Cart

» Farkli Olctilerde ilac Saklama Cekmeceleri
> Antistatik Kilitlenebilir Tekerlekler

> SUrgilu Gizlenebilir Yazi Tahtasi

> Merkezi Kilit Sistemi

> Kapakli Cop Kovasi

» Drug Storage Drawers In Different Sizes
> Antistatic Lockable Wheels

> Sliding Foldable Writing Board

> Central Lock System

> Dustbin With Lid

Tu
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Discover
the potential
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SeaMed FT-2800 Kan ve Serum Isitici SeaMed’
SeaMed FT-2800 Blood and Infusion \Warmer

¥ Yiksek Performans Citfli Kuru Isitma Sistemi
» Mikro Islemci Kontrolli

> Medikal Sivilar igin Standart Setler ile Uyumlu
> Isttici Profil Tutuculu

> Sicaklik Kontroléri Sayesinde Yuksek Dogruluklu Calisma

> High Performance Double Dry Heating System

> Micro Processor Controlled

> Compatible With Standard Sets for Medical Fluids
> With Heater Profile Holder

> High Accuracy Operation to the Temperature Controller

SeaMed S8 Defibrilator Cihazi seaMecd’
SeaMed S8 Defibrillator Device

> 84" TFT LCD Renkli Ekran > 84" TFT LCD Color Screen
> Pediatrik ve Yetiskin Hastalarda > Possibility of Use In Pediatric and
Kullanim Imkani Adult Patients
> 1-360 Joule Arasi Enerji Secimi > Energy Selection Between [-360 Joules
> Bataryasi ile 6 Saate Kadar Kullanabilme ¥ Use up to 6 Hours With Its Battery
> Opsiyonel SpO, / EtCO, / > Optional SpO,/ EtCO, /
NIBP Ozellikli NIBP Features

Zerone Zeus-400
Elektrokoter Cihazi @ ZERONE

Zerone Zeus-400 Electrocautery Device

» Mikro Islemci Kontrollii Giivenilir Calisma > Micro Processor Controlled Reliable Operation

> Kesme, Koagllasyon ve Bipolar Kullanim Modlan > Cutting, Coagulation and Bipolar Usage Modes

> Spray ve Kontakt Koagullasyon > Spray and Contact Coagulation

> Koter Kalemi veya Ayak Pedall ile Rahat > Comfortable Working With Cautery Pen or
Calisma Imkan Foot Pedal

» 400 Watt Cikis GlcU > 400 Watt Output Power

> Opsiyonel Argon Plasma Koagtilasyon Uyumlulugu > Optional Argon Plasma Coagulation Compatibility
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Cheiron Versa Cerrahi Aspiratér Cihazi =

v/

Cheiron Versa Surgical Aspirator Device Cheiron
> Tum Cerrahi iglemlgrde Sessiz ve > Silent and Non-Vibration Working

Titresimsiz Calisma Imkani Opportunity in All Surgical Operations =
> Ayak Pedali ile Kolay Kullanabilme » Easy to Use with Foot Pedal -
> 394 dB Ses Seviyesi » 39.4 dB Sound Level 71 M4
> Mikro biyolojik Bakteri Filtresi » Micro Biological Bacteria Filter \ !
> Asint Akis Koruma Sistemi » Overflow Protection System ' o E ; !
> Surekli Calismaya Uygun Tasarim » Design Suitable for Continuous Working : i - Q

> Isinmaya Karsi Ekstra Fan lle Sogutma ~ » Cooling with Extra Fan Against Heating

Cheiron Liposuction Aspirator Cihazi =

Cheiron Liposuction Aspirator Device Cheirén
..we breathe for you.
% Liposuction Islemlerde Sessiz ve > Quiet and Vibration-Free Working
Titresimsiz Calisma Imkani Opportunity in Liposuction Operations
» -1 Bar'a Kadar Vakum Gict » Vacuum Power up to -1 Bar

> Avyak Pedali ile Kolay Kullanabilme » Easy to Use with Foot Pedal

> 39,4 dB Ses Seviyesi » 39.4 dB Sound Level

> Mikro biyolojik Bakteri Filtresi » Micro Biological Bacteria Filter

> Asin Akis Koruma Sistemi » Overflow Protection System

> Surekli Calismaya Uygun Tasarim » Design Suitable for Continuous Working

¥ Isinmaya Karsi Ekstra Fan lle Sosutma  » Cooling With Extra Fan Against Heating

SeaMed infiltrasyon Pompasi SeaMed’
SeaMed Infiltration Pump

> Liposuction Sivi Verme Islemlerinde  » It Can Be Used In Liposuction Fluid

Kullanilabilir Giving Processes )
> Hiz Araligi 0.5 — 600 rpm. > Speed Range 0.5 - 600 rpm.
> Minimum G Tuketimi > Minimum Power Consumption
> Hafif Kompakt Tasarim > Lightweight Compact Design

www.denizlermedikal.com




Anahtar Teslim
Sterilizasyon Sistemleri

Turnkey Sterilization Systems

Discover
the potential
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Hidrojen Peroksit (H203)

Sterilizasyon Cihazi

Hydrogen Peroxide (H202) Sterilization Device

> Dokunmatik Kontrol Paneli

> Dahili Termal Yazici

> Uretim Standartlari : 1ISO 9001, ISO 13485 ve ISO 1400
> Sterilizasyon Suresi : 30 Dakika

> Touchscreen Control Panel
> Internal Thermal Printer
> Production Standards: ISO 9001, ISO 13485 and ISO 14001

> Sterilization Time: 30 Minutes

Discover
the potential

www.denizlermedikal.com




1 Otoklav Cihazi

Autoclave Device

> Paketli ve Paketsiz Dental, Ameliyathane Malzemelerinin, Plastik ve Cam Malzeme
Sterilizasyonu Icin Kompakt Dizayn

» Mikro Islemcili Kontrol Sistemi
> Dokunmatik Renkli Kontrol Paneli
» 7 Adet Hazir, 1 Adet Sivi, 1 Adet Kurutma ve 50 Adet Ozel Program Hafizasi

> Test Programlar: Bowie & Dick ve Vakum Testi

> Compact Design For Sterilization of Packed and Unpackaged Dental, Operating
Room Materials, Plastic and Glass Materials

> Microprocessor Control System
> Touchscreen Color Control Panel
> 7 pcs. Ready-Made, 1 pc. Liquid, 1 pc. Drying and 50 pcs. Program Memories

> Test Programs: Bowie & Dick and Vacuum Test

Discover B 5
the potential ' e IR T
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Kesme - Kapama Cihazi
Cutting - Sealing Machine

» Kapama, Yazma ve Etiketleme Ayni Anda Islem Yapabilme
> Renkli Dokunmatik Kontrol Paneli

> Saatte 5000 Paket Uretim Hizi

> Uyku Modu ile Enerji Tasarrufu

> Kullanici Emniyeti Acil Stop Butonu

> Opsiyonel Karekod Okuyucu

> Closing, Writing and Labeling to Operate at the Same Time
> Color Touchscreen Control Panel

> 5000 Package Production Speed Per Hour

> Energy Saving With Sleep Mode

> User Safety Emergency Stop Button

> Optional Datamatrix Reader

Yikama Dezenfeksiyon ve

Kurutma Cihazi
Washing Disinfection and Drying Device

-

é._'\
> Dokunmatik Renkli Kontrol Paneli

> Program Sayisi: 50 Adet
> Kabin Hacmi: 250 Litre
> 600 It/dk. Devir Daim Pompasi

> Opsiyonel Yazicl, Su Yumusatma Sistemi

> Touchscreen Color Control Panel
> Number of Programmes: 50 pcs.
> Cabin Volume: 250 It

> 600 It / min. Recirculation Pump

> Optional Printer, Water Softening System &

Discover
the potential

www.denizlermedikal.com
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Medikal Oksijen Uretim
Sistemleri

Turnkey Medical Oxygen Generating Systems
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Medikal Oksijen Uretim Sistemleri
Medical Oxygen Generating Systems

> Kalite Standartlar: ISO 10083

> Manual, Otomatik ve Servis Modu

> Calisma Teknigi: Degisken Basing Altinda Filtreleme (PSA)
> TUm Hastane Kosullarina Uygun Kurulum Ve Montaj Imkani

» Standart %95 Saflikta Cikis Ozelligi

Quality Standards: ISO 10083
Manual, Automatic and Service Mode
Working Technique: Filtering Under Variable Pressure (PSA)

Installation and Assembly Opportunity Suitable for
All Hospital Conditions

Standard 95% Purity Output Feature

Turkey

Discover
the potential

www.denizlermedikal.com




Anahtar Teslim
Medikal Gaz Sistemleri

Turnkey Medical Gas Systems
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Discover
the potential
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Yatak Basi Medikal

Gaz Uniteleri
Bedside Medical Gas Units

> Oksijen, Hava ve Vakum Prizleri

> Telefon, Internet ve Hasta Cagri Sistem Cikislari

> Ray Tagima Sistemi : Max. 100 Kg. — __'_"'

> Elektrik ve UPS Prizleri | @r @ G
| e |

s e A i Vo O N R ===t W |

> Phone, Internet and Patient Call System Outputs
> Rail Transport System: Max. 100 kg.
> Electricity and UPS Sockets

&X@Jg%

K

Discover
the potential
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Anahtar Teslim

Paslanmaz Celik Hastane
Ekipmanlari

Turnkey Stainless Steel Hospital Equipment

i%w %@% *%\fﬁ\\i

Discover
the potential
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the potential

» Ameliyathane Dolabi > Bone ve Maske Dolabi > Alet Masasi
> Operating Theatre Cabinet > Bonnet and Mask Cupboard > Instrument Table

> Calisma Masasi > El Yikama Evyesi
> Working Table > Washing Sink

> Malzeme Dolabi > Mayo Masasi > Tibbi Atik Arabasi
> Instrument Cabinet > Mayo Table > Medical Waste Trolley

19
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Anahtar Teslim
Radyoloji Sistemleri

Turnkey Radiology Systems
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Dijital Rontgen Cihazi

Digital X-Ray Device

> Sessiz Hareket Etme ve Kolay Kullanim > Quiet Movement and Easy Operation

> Kolay Kurulum > Easy Setup

> DICOM Uyumlu ve PACS'a Kolaylikla Baglanabilme > Easy to Connect to PACS and DICOM Compatible

> X-Ray Jeneratérinin Tam Kontrold > Full Control of X-Ray Generator
> En Fazla 2 Saniyede %100 Dijital > Access to 100% Digital Images in
Gorintilere Erisebilme Maximum 2 Seconds

Discover
the potential

www.denizlermedikal.com




C Kollu Skopi
C-Arm Scopy

> Hasta Erisilebilirligine gore Hizli ve Kolay Konumlandirma > Rapid & Easy Positioning With Patient Accessibility

> Tam Otomatik Kontrol ile Yiksek Guvenilirlik > High Reliability with Full Automatic Control

> Esnek C-Kol Hareketleri > Flexible C-Arm Movements

> DVD/CD/USB Yazic, Basili Kopya veya Yazic > DVD/CD/USB Writer, Hard Copy Film or Printer
> Opsiyonel DICOM > Optional DICOM Internal Interface

22
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Otomatik Enjektor

Pompasi
Automatic Injector Pump

> Kablosuz Baglantisi ile Kolay Kullanim

> Dokunmatik LCD Kontrol Ekrani

> Baslatma ve Durdurma icin EI Kumandasi

> Otomatik veya Manual Siringa Doldurma Fonksiyonlari

> Easy to Use With Wireless Connection
> Touchscreen LCD Control Screen
> Hand Control for Start and Stop

> Automatic or Manual Syringe Fill Functions

Seyyar Rontgen Cihazi
Portable X-Ray Device

> HF Yiksek Frekansli ve Yiksek Isi Kapasitesi

> Hastane, Mobilize Kliniklerde Yatan Hastalar
Icin Kolay Kullanim Olanag)

> Kolay Suris Ve Efektif Kullanim
> Manuel / Otomatik Kontrol
> Opsiyonel DICOM

> HF High Frequency and High Heat Capacity

> Easy-to-Use Opportunity for Hospitalized
Patients in Mobilized Clinics g‘j :

> Easy Driving and Effective Use

= 4
¥ Manual / Automatic Control

> Optional DICOM

Discover
the potential

www.denizlermedikal.com




Anahtar Teslim
Yogun Bakim Projeleri

Turnkey Intensive Care Projects

Discover
the potential
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Neumovent Yogun Bakim

Ventilator Cihazi
Neumovent Intensive Care Ventilator Device

Renkli Dokunmatik TFT LCD Ekran

Yetiskin, Pediatrik ve Yenidogan Kullanim Modlari
Tidal Hacim: 5-2500 ml

Dustk Maliyetli Bakim Imkani

Kullanim Modlan: VCV/PCV/PSV/CPAP/ SIMV(PCV)+PSV/
SIMV(VCV)+PSV/ MMV+PSV/PSV+VT ASSURED/APRV/NIV/
TCPL/SIMV(TCPL)+PSV/CPAP + Sirekli akis

v vV VvV VvV Vv

Color Touchscreen TFT LCD Screen
Adult, Pediatric and Neonatal Using Modes
Tidal Volume: 5-2500 ml

Low Cost Maintenance Opportunity

Usage Modes: VCV / PCV / PSV / CPAP / SIMV (PCV) + PSV /
SIMV (VCV) + PSV / MMV + PSV / PSV + VT ASSURED /
APRV / NIV / TCPL/ SIMV (TCPL) + PSV / CPAP + Steady flow

v VvV VvV VvV Vv

neumovent neo

-
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Tecme

committed to life
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MdkMed 1Z-15

Hastabasi Monitori
MdkMed |Z-15 Patient Monitor

> EKG, NIBP, RESP, PR, SpO, , TEMP ve 2xIBP Parametreleri
> |5" Dokunmatik Renkli TFT LCD Ekran

> 3 Seviyeli Sesli ve Gorsel Alarm

> Opsiyonel Merkezi Monitor Sistem Baglantisi

> Opsiyonel EtCO, (Kapnograf) Parametresi

> ECG, NIBP, RESP, PR, SpO,, TEMP and 2xIBP Parameters
> |5” Touchscreen Color TFT LCD Display
> 3 Level Audible and Visual Alarm

> Optional Central Monitor System Connection

> Optional EtCO, (Capnograph) Parameter

SeaMed XM-550

Hastabasi Monitori
SeaMed XM-550 Patient Monitor

> EKG, NIBP, RESP, PR, SpO, ,TEMP ve 2xIBP Parametreleri
> 104" veya 12.1" Renkli TFT LCD Ekran e _

XM550

.

> 3 Seviyeli Sesli ve Gorsel Alarm
AM330

> Dahili 6 Saate Kadar Batarya

> Opsiyonel Merkezi Monitor Sistem Baglantisi

> Opsiyonel EtCO, (Kapnograf) Parametresi

> ECG, NIBP, RESP, PR, SpO,, TEMP and 2xIBP Parameters
> 104" or 12.1” Color TFT LCD Display

> 3 Level Audible and Visual Alarm

> Up to 6 Hours Built-in Battery L L)
> Optional Central Monitor System Connection |

> Optional EtCO, (Capnograph) Parameter

26
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MdkMed MI-27

inflizyon Pompasi MDK<Med
MdkMed MI-27 Infusion Pump

> Set Bagimsiz Peristaltik Pompa » Set Free Peristaltic Pump

» TUm Infizyon Setleri ile Calisabilme > Ability to Work with All Infusion Sets

> Tirkge Kullanim MenUsu > Turkish User Menu

» Mikroislemci Kontrollt Givenilir ve Hassas Calisma ¥ Microprocessor Controlled Reliable and Precise Operation
> KVO, Bolus ve Purge Fonksiyonlan > KVO, Bolus and Purge Functions

> Sesli ve Gorsel Alarmlar > Audible and Visual Alarms

> Opsiyonel Wi-Fi destegi ile HBYS'ye Baglanabilme > Connecting to HBYS With Optional Wi-Fi Support

MOK G g

Qeg L

omes Lk
. ] 50 (
™ : Y 5 @086  @15s0mL Z12815mL

sss el a

@S  #Dopemine 120kpa

MdkMed MS-37

Enjektor Pompasi MDK<%Med
MdkMed MS-37 Syringe Pump

> Set Bagimsiz > Set Free

> TUm Enjektorler lle Calisabilme > Ability to Work with All Syringe

> Turkge Kullanim MenUsu > Turkish User Menu

> Otomatik Enjektor Tanima > Automatic Syringe Recognition

> Mikroislemci Kontrollid Guvenilir ve Hassas Calisma > Microprocessor Controlled Reliable and Precise Operation
> KVO, Bolus Ve Purge Fonksiyonlar > KVO, Bolus and Purge Functions

> Sesli Ve Gorsel Alarmlar > Audible and Visual Alarms

> Opsiyonel Wi-Fi Destegi ile HBYS'ye Baglanabilme » Connecting to HBYS with optional Wi-Fi Support

2020-05-06 17:16:15

Homea

1 t A

&5 & Dopaming 120kpa
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Ampall PCA Agri Pompasi
Ampall PCA Pain Pump

> Mikroislemci Kontrollid Guvenilir ve Hassas Calisma

> Tlrkce Kullanim Mendst

% llag Ismi ve Inflizyon Bilgisi Kaydedebilme

> Her Acllista Kendini Test Etme l
> KVO, Bolus ve Purge Fonksiyonlari
> Sesli ve Gorsel Alarmlar

> Batarya ile Kullanim imkani ) Q @

START STOP

1

O T TTTTIT T oty

T
n.r

> Microprocessor Controlled Reliable and Precise Operation

Open door and install line like this picture

> Turkish User Menu

lever
and inser ling

Open

> Saving Drug Name and Infusion Information

> Self Test At Each Power On
> KVO, Bolus and Purge Functions
> Audible and Visual Alarms

y' all
» Possibility of Use with Battery —

SeaMed BN-702

Yikamali Beslenme Pompasi
SeaMed BN-702 Feeding Pump With Automatic Flushing

> Renkli TFT LCD Ekran

> Set Bagimsiz Kolay Kullanim

> Bolus ve Purge Fonksiyonlari

> Seffaf Izlenebilir Pompa Kapag

> Dahili Batarya ile 8 Saate Kadar Kullanim

> Color TFT LCD Screen

> Set Free Easy to Use

> Bolus and Purge Functions

> Transparent Viewable Pump Cover

> Up to 8 Hours of Use with the Internal Battery

SeaMed
28
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SeaMed Kapnometre Cihazi _
SeaMed Capnometer Device fS €icEs

> Yenidogan, Cocuk ve Yetiskin Hastalarda Kullanabilme
> EtCO, /CO,, Solunum Parametrelerini Izleyebilme

> EtCO, Parametrelerini Grafiksel Olarak izleyebilme

> Sesli ve Gorsel Alarmlar

> Opsiyonel USB Portu Ile Bilgisayara Data Aktarimi

> Use in Neonatal, Child and Adult Patients

> EtCO, / CO,, Ability to Monitor Respiratory Parameters

> Graphically Monitoring EtCO, Parameters /‘
> Audible and Visual Alarms ™ ’“3 /
> Data Transfer to Computer with Optional USB Port ( \

‘ez

SeaMed PC-900B

Kapnograf & Sp0O2 Cihazi
SeaMed PC-900B Capnograph & SpO2 Device

> Renkli TFT LCD Ekran

> Yenidogan, Cocuk ve Yetiskin Hastalarda Kullanabilme
> EtCO,, Solunum ve SpO, Parametrelerini izleyebilme
> EtCO, Grafiksel Olarak Izleyebilme

> 10 Saat Kadar Batarya Suresi

> Sesli ve Gorsel Alarmlar

> Color TFT LCD Screen

2 Use in Neonatal, Child and Adult Patients

> Monitoring EtCO,, Respiratory and SpO, parameters
> Graphically Monitoring EtCO,

> Up to 10 Hours of Battery Time

> Audible and Visual Alarms

www.denizlermedikal.com




Insighters iS-3L Video Laringoskop
Insighters iS-3L Video Laryngoscope

> 35" Dokunmatik LCD Ekran > 3.5" Touchscreen LCD Display

> HD Gériinti Kalitesi > HD Image Quality

> TUm Hastalar ile Uyumlu : > Compatible With All Patients:
Yetiskin,Pediatrik, Yenidogan Adult, Pediatric, Neonatal

> Fotograf ve Video Kaydi > Photo and Video Recording

> Anti-fog Ozelligi > Anti-fog Feature

. 9

insighters

SeaMed Yogun Bakim ila¢ Arabasi

SeaMed Intensive Care Medicine Cart

¥ Farkli Olciilerde ilag Saklama > Drug Storage Drawers in
Cekmeceleri Different Sizes
> Antistatik Kilitlenebilir Tekerlekler > Antistatic Lockable Wheels
» Slrgilt Gizlenebilir Yazi Tahtasi > Sliding Foldable Writing Board
> Merkezi Kilit Sistemi > Central Lock System
> Kapakl Cop Kutusu > Dustbin With Lid
®
SeaMed

SeaMed S8 Defibrilator Cihazi
SeaMed S8 Defibrillator Device

> 84" TFT-LCD Renkli Ekran > 84" TFT-LCD Color Screen

> Pediatrik ve Yetiskin Hastalarda > Possibility of Use in Pediatric and
Kullanim Imkan Adult Patients

> [-360 Joule Arasi Enerji Secimi > Energy Selection Between

> Bataryasi ile 6 Saate Kadar Kullanabilme 1-360 Joules

> Opsiyonel SpO, / EtCO, / NIBP Ozellikli > Use up to 6 Hours With its Battery

> Optional SpO, / EtCO, / NIBP Features
®
SeaMed

30
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Ordek Siirgii Yikama Sistemleri i ‘
Bed Pan Washing and Disinfection Device

> Modern Teknolojik, Hastalar icin > Modem Technology, Ultra Hygienic
Ultra Hijyen Gulvenligi Safety For Patients

» Buhar Sizdirmazligi ile Is Guvenligi, > Work Safety With Steam Tightness,
> Cok Fonksiyonlu Tutucu Konsepti > Multifunctional Gripper Concept

> Fiftrelenmis Hava ile Kurutma- > Drying-Cooling Process With
Sogutma Islemi Fittered Air
» Dahili Sicaklik Kontrol Sensorleri > Internal Temperature Control Sensors

SeaMed Yogun Bakim Hasta Yatagi SeaMed’
SeaMed Intensive Care Patient Bed

> Kolay Temizlenebilir Hijyenik Yapi > Easy to Clean Hygienic Structure

> UV ve Gines Isinlarina Dayanikli > Special Plastic Material With
Koruma Tabakasina Sahip UV and Sunlight Resistant
Ozel Plastik Malzeme Protection Layer

> El Kumandasi ile Kolay Kontrol imkani » Easy Control With Hand Control

> Elektrik Kesintisine Karsi Batarya > Battery Support Unit Against
Destek Unitesi Power Cut

SeaMed Yogun Bakim Havali Yatak SeaMed’
SeaMed Intensive Care Air Mattress

> 200 kg Kadar Hasta Tasima Kapasitesi ¥ Patient Carrying Capacity up to

> 90°C de Yikanabilir Kilif 200 kg
> Alternatif ve Statik Modda Calisabilme > Cover Washable at 90°C
> CPR Fonksiyonu » Working in Alternative and Static Modes

> CPR Function

www.denizlermedikal.com




Anahtar Teslim
Yenidogan Yogun Bakim
Projeleri

Turnkey Neonatal Intensive Care Projects

o ; wae & 7 0 m

Discover
the potential
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Neumovent Yenidogan K“

|

Yogun Bakim Ventilator Cihazi | [: '

Neumovent Neonatal Intensive oL
Care Ventilator Device

> Renkli Dokunmatik TFT LCD Ekran i 1)

> 2 ml Tidal Hacim Baglangici

> Dtk Maliyetli Bakim Imkani

> Kullanim Modlan: VCV/PCV/PSV/CPAP/ SIMV(PCV)+PSV/
SIMV(VCV)+PSV/ MMV+PSV/PSV+VT ASSURED/APRV/NIV/TCPL/ 5 w J zz
SIMV(TCPL)+PSV/CPAP + Surekli Akis

> Color Touchscreen TFT LCD Screen neumovent neo

> 2ml Tidal Volume Start

> Low Cost Maintenance Opportunity

'—: .I II..T- < : (‘ rll- : Eog II

> Usage Modes: VCV / PCV / PSV / CPAP / SIMV (PCV) + PSV /
SIMV (VCV) + PSV / MMV + PSV / PSV + VT ASSURED / APRV /
NIV / TCPL / SIMV (TCPL) + PSV / CPAP + Steady Flow

Tecme

committed to life

SeaMed Yenidogan

Yogun Bakim Kuvozi SeaMed’
SeaMed Neonatal Intensive Care Incubator

> Mikroislemci Servo Kontrollti, Hassas ve Giivenilir Sicaklik Kontrol(
> Sicaklik Kontrolt; Hava ve Cilt Kullanim Modlar

> Dijital Ekranda Hassas Nem Kontrol{
% Dahili LED Fototerapi Unitesi
> Dahili Bebek Terazi Unitesi

> Microprocessor Servo Controlled, Precise and Reliable
Temperature Control

> Temperature Control: Air and Skin Usage Modes
> Precise Humidity Control On Digital Display

> Built-in LED Phototherapy Unit

> Built-in Baby Scale Unit

www.denizlermedikal.com




SeaMed LED

Fototerapi Cihazi o
SeaMed LED Phototherapy Device ===y

> TUm Kuvdzler ile Uyumlu Tasarim L'
> Yiksek Yogunluklu LED Fototerapisi
> Avarlanabilir Isima Seviyesi

> Avyarlanabilir Zaman Modu

> Design Compatible With All Incubators
> High Intensity LED Phototherapy

> Adjustable Radiance Level
> Adjustable Time Mode

SeaMed Tiinel Tipi

Fototerapi Cihazi
SeaMed Tunnel Type Phototherapy Device

> Dokunmatik LCD Kontrol Paneli
» Kabin lci Sicaklik Kontrolii
> Farkl Kademelerde Ayarlanabilir Isima Yogunlugu

> Avarlanabilir Zaman Modu

> Touchscreen LCD Control Panel
> In-cabin Temperature Control

> Adjustable Luminous Intensity at Different Levels

> Adjustable Time Mode

SeaMecl o

34



S DENIZLER
P MEDIKAL
" SeaMed Radyant Isitici

SeaMed Radiant Warmer |

> Dustk-Yuksek Sicaklik Kontrold

> LCD Kontrol Paneli -I
1
[

> Gorsel ve Isitsel Alarm Fonksiyonu

> X-Ray Kaset Takma Yeri e
1 U
> LCD Control Panel o mﬁ?ﬂr

> Low-High Temperature Control

> Visual and Auditory Alarm Function
H“-__.r-""
> X-Ray Cassette Chamber rj‘ % -

SeaMed T Par¢a

Canlandirici
SeaMed T Piece Resuscitator

> Kolay ve Pratik Kullanim
> Tasinabilir Hafif Kompakt Tasarim
> %21 - %100 Arasi Ayarlanabilir Oksijen Seviyesi

> -10 ile 80cm H,O izlenebilir Manometre

> Easy and Practical Use
> Portable Lightweight Compact Design
> Oxygen Level Adjustable From 21% to 100%

> -10 to 80cm H,O Traceable Manometer

www.denizlermedikal.com




Kejian KJ-8000

Bilirubinmetre Cihazi
Kejian KJ-8000 Bilirubinmeter Device

i 5 '-’-_g,%. ; )
:
\N
Ele'ﬁg‘rus
‘: I.Sn.c“‘- i suoﬂ
W e
|| . wm,u-'
‘ | 1 Jpuré®’

» Yeni Nesil Fiber, Fotoelektrik ve Bilgi Isleme Teknolojisi > New Generation Fiber, Photoelectric and Information

_ Processing Technology
> Bebegi Rahatsiz Etmeden Hizli Sonug Alma

» > Quick Result Without Disturbing the Baby
> Kolay Okunabilir LCD Ekran

- > Easy to Read LCD Display
> Hizli Sarj ile 3 Saatte Tam Batarya Dolumu

. . . > Full Battery Charge in 3 Hours With Quick Charge
> Otomatik Kalibrasyon Ozelligi

¥ Auto Calibration Feature

AP KEJIAN

36



|=) "medika

MdkMed MI-27 MDK %“Med

Infiizyon Pompasi
MdkMed MI-27 Infusion Pump

> Set Bagimsiz Peristaltik Pompa > Set Free Peristaltic Pump

> Tum Infiizyon Setleri ile Calisabilme > Ability to Work with All Infusion Sets

> Tirkce Kullanim Menisi > Turkish User Menu

» Mikroislemci Kontrollii Givenilir ve Hassas Calisma > Microprocessor Controlled Reliable and Precise Operation
> KVO, Bolus ve Purge Fonksiyonlan > KVO, Bolus and Purge Functions

> Sesli ve Gorsel Alarmlar > Audible and Visual Alarms

> Opsiyonel Wi-Fi destegi ile HBYS'ye Baglanabilme > Connecting to HBYS with optional Wi-Fi support

e #Dopemine 120kpa

. 503,

001836 & 1580 mL ZTA12R15mL

sss el a

MdkMed MS-37 Enjektor Pompasi
MdkMed MS-37 Syringe Pump MDKYMed

> Set Bagimsiz Yapi Set Free Structure

> TUm Enjektorlerile Calisabilme Ability to Work with All Syringe
> Tirkge Kullanim MenUsi Turkish User Menu
» Otomatik Enjektor Tanima Automatic Syringe Recognition
> Mikroislemci Kontrolli Guvenilir Ve Hassas Calisma Microprocessor Controlled Reliable and Precise Operation
> KVO, Bolus Ve Purge Fonksiyonlari KVO, Bolus and Purge Functions
Audible and Visual Alarms

Connecting to HBYS with optional Wi-Fi Support

> Sesli Ve Gorsel Alarmlar

v VvV VvV VvV V V VvV Vv

> Opsiyonel Wi-Fi Destegi ile HBYS'ye Baglanabilme

2020-05-06 17:16:15
Homea

1 v = T =

&5 & Dopaming 120kpa

mL/h
N - 50 0/0)
- \ - 2 |
3 @ 00:18:36 @ 1680 mL Z12815mL
- ; ewe a ral
. J v

www.denizlermedikal.com




Anahtar Teslim
Kardiyoloji Poliklinigi

Turnkey Cardiology Polyclinic

Discover
the potential
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Eforlu EKG Test Cihazi
Stress ECG Test Device

> 12 Kanal Eszamanli Tam Kayit EKG Ritmi

> Kan Basin¢ Olctimi: Otomatik ve Manual
> Parazit Onleyici Filtre Secenekleri
> Elektrot Temassizlik Tespiti

> Gelismis Analiz Teknolojisi

> 12 Channel Simultaneous Full Recording
ECG Rhythm

> Blood Pressure Measurement:
Automatic and Manual

> Anti-Interference Filter Options
> Electrode Non-Contact Detection

> Advanced Analysis Technology

SeaMed H12 EKG Cihaz
SeaMed H12 ECG Device

> 10" Dokunmatik LCD Ekran
> Otomatik Aritmi Tespiti ve Raporu

> DICOM, BMP, JPG, PDF, SCP-ECG, FDA-XML
Formatlarinda Raporlama

> Hastane Bilgi Yonetim Sistemine Baglanabilme

> 10" Touchscreen LCD Screen
> Automatic Arrhythmia Detection And Report

> Reporting In DICOM, BMP, |PG, PDF, SCP-ECG,
FDA-XML Formats

> Connecting to the Hospital Information Management System

www.denizlermedikal.com




EdanIT20

Telemetri Cihazi
Edan [T20 Telemetry Device

> Kolay Okunabilen OLED Ekran

> EKG, Solunum, SpO,, PR Parametrelerini Izleyebilme
> 64 Adet Cihaz Ayni Anda Sisteme Baglanabilme

> Hemsire Cagri ve Hasta Cagri Fonksiyonlar

> Wifi ile Merkezi Sisteme Baglanabilme

> Easy to Read OLED Display
> Monitoring ECG, Respiration, SpO,, PR Parameters

» 64 pcs. Devices can be Connected to the
System at the Same Time

> Nurse Call and Patient Call Functions

> Connecting to the Central System With Wifi EDAN

SeaMed Wi-Fi

Mobil Ultrason Cihazi
SeaMed Wi-FI Mobile Ultrasound Device

> Telefon/Tablet ile Kullanim imkani

> Hafif ve Kompakt Tasarnmi

» Renkli Doppler Ozellikli
> B, B/M, PW ve PDI Gérinttleme

> 128 Adet Seramik Piezzo Elektrik Elementli

> Possibility of Use With Phone/Tablet Computer

> Lightweight and Compact Design “

> Color Doppler Specific u

> B, B/M, PW and PDI View

> 128 pcs. Ceramic Piezzo With Electrical Elements 5 ®
eaMed
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SeaMed BS6930

Ritim Holter
SeaMed BS6930 Rhythm Holter

> 7 Glne Kadar Kaydetme Kapasitesi
> Konforlu ve Hafif Tasarm

> 3/12 Kanallr Calistirmaya Uygun

> SD Kart Destekli

> Kalp Pili Omeklemesi

A

> Up to 7 Days of Recording Capacity / 3 @ '

> Comfortable and Lightweight Design / 4 ® @ ®

> Suitable For 3/12 Channel Operation // 4 \ \
> SD Card Supported ‘ ‘ ‘ \

» Pacemaker Sampling

SeaMed Echo
Tansiyon Holter
SeaMed Echo Blood Pressure Holter

> Kompakt ve Hafif Tasarnm

> TUm Hastalarda Kullanima Uygun

> Dustk Gic Tuketimi Sayesinde Uzun Batarya Omrii
> Tasima Cantasi ve Kullanima Uygun Mansonlar

> Yazilimi Sayesinde Kolay Analiz

> Compact and Lightweight Design

> Suitable For Use In All Patients
> Long Battery Usage Due to Low Power Consumption
> Carrying Bag and Sleeves Suitable for Use

> Easy Analysis to Its Software

www.denizlermedikal.com
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Ifadln Dogum Hastaliklari
Unitesi

Turnkey Obstetrics and Gynecology Unit

Ve £3\

Discover
the potential
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SeaMed Star5000 NST Cihazi
SeaMed Star5000 Fetal Monitor

> 12.1” Renkli Dokunmatik Katlanabilir > 12.1" Color Touchscreen
LCD Ekran Foldable LCD Display
» TOCO, FHRI, FHR2 FM, Dahili Termal > TOCO, FHRI, FHR2 FM,
Yazici Konfiglirasyonlari Internal Thermal Printer ~ {: f
> USB Bellege Veri Aktarabilme Ozelligg ~ Configurations e o7
% Su Gecirmez FHR ve TOCO Problart > Data Transfer Feature to USB Memory S —— (- 0
> Merkezi Fetal Monitor Sistemine > Waterproof FHR and TOCO Probes

Baglanabilme > Connecting to Central Fetal Monitoring

System SeaMed

SeaMed Star5000C Maternal NST Cihazi
SeaMed Star5000 Maternal Fetal Monitor

> 12.1” Renkli Dokunmatik Katlanabilir > 12.1”" Color Touchscreen
LCD Ekran Foldable LCD Display

> EKG,SPO?2, PR, NIBP, ISI ve Solunum » Monitoring EKG, SPO2, PR, NIBP,
Parametrelerini Izleyebilme ISI and Respiration Parameters

> TOCO, FHRI, FHR2 FM, > TOCO, FHRI, FHR2 FM, Internal >
Dahili Termal Yazici Konfiglirasyonlar Thermal Printer Configurations '

> USB Bellege Veri Aktarabilme Ozellisi ~ » Ability to Transfer Data to USB Memory
> Su Gecirmez FHR ve TOCO Problart » Waterproof FHR and TOCO Probes

> Merkezi Fetal Monitor Sistemine > Connection to the Central Fetal Monitor

Baglanabilme System SeaMed

SeaMed T12 Kablosuz NST Cihazi

Seamed T12 Wireless Fetal Monitor

> 12.1" Renkli LCD Katlanabilir Ekran > 12.1" Color LCD Foldable Screen

> TOCO, FHRI, FM, Dahili Termal Yazicc  » TOCO, FHRI, FM, Internal Thermal
Konfiglirasyonlar Printer Configurations

> Kablosuz FHR, TOCO Problar > Wireless FHR, TOCO Probes
> Su Gecirmez FHR ve TOCO Problart ¥ Waterproof FHR and TOCO Probes

www.denizlermedikal.com



Optomic OP-C5 .
Binokiiler Kolposkopi Cihazi >
Optomic OP-C5 Binocular Colposcopy Device o \

Egik Durbinli Stereoskopik Kafa ve Diiz Dirbiinle Kullanim Imkani
Halojen, Xenon veya LED Isik Kaynagi
Fiberoptik Kablo Sayesinde YUksek Aydinlatma Yogunlugu

Her iki Gézdede Kaucuk Géz Korumasi

v VvV VvV VvV Vv

Buytitme Araligr: 2.5x-27x !

> Possibility to Use With Tilted Stereoscopic Head and Straight Binoculars e’;' ':jh ﬂt*ﬁ

> Halogen, Xenon or LED Light Source

> High Lighting Intensity to Fiberoptic Cable = 1 -9

> Rubber Eye Protection on Both Eyes . s w
> Magnification Range: 2.5x-27x m

SeaMed KN-2200I (HD)

Kolposkopi Cihazi

SeaMed KN-2200I (HD)
Colposcopy Device

> 175 Cesit Vakaya Uygun Konfiglire Edilmis Ara YUz ve Yazilim

> Video Kaydi, Goriinti Dondurma, Dizenleme, Kesit Alma,
Rapor Ciktisi AlIma ve Saklama

» Goruintlyl Blyltme, Kiiclltme, Isaretleme, Bolgesel Blyiitme

> Rapor Duizenleme, Yazdirma, Hazir Sablonlar, Teshis Raporlama,
RGB Goriintt Baskisi

> Configured Interface and Software for 175 Kinds of Cases

> Video Recording, Image Freezing, Editing, Sectioning, Report
Output and Storage

> Image Enlargement, Reduction, Marking, Regional Enlargement

> Report Editing, Printing, Ready Templates, Diagnostic Reporting,
RGB Image Printing

SeaMed
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SeaMed KS-Q5N

Muayene Lambasi
SeaMed KS-Q5N Examination Lamp

> Dimmer ile Kadameli Olarak Isik Ayari
> 5 Tekerlekli Frenli Sistem
> Ix LED lsik Kaynagi

> Ayarlanabilir Aydinlatma Alan Capi

> Gradual Light Adjustment With Dimmer
> 5 Wheel With Brake System
> Ix LED Light Source

> Adjustable Lighting Field Diameter

SeaMed KS-Q7

Muayene Lambasi P
SeaMed KS-Q7 Examination Lamp

> 7 LED Aydinlatma
> 5 Tekerlekli Frenli Sistem | 5
> 5 Seviye Parlaklik Kontrolt r

> 320° Hareket Ettirilebilen Baslik

> 7 LED Lighting
> 5 Wheel With Brake System

> 5 Levels of Brightness Control
> Head that can be Moved 320°

www.denizlermedikal.com




SeaMed Jinekolojik

Dogum Yatagi
SeaMed Gynecological Delivery Bed

> 3 Adet DC Motor ile Kontrol

> Litonomi, Kardiyak ve Yatak Pozisyonlan #

> 3 Bolimden Olusan Suni Deri Kaplamali
Sabit Déseme YUzeyi.

> El Kumandasi ile Kolay Kullanim

> Metal Aksamlar Elektrostatik Toz Boyali

> Control With 3 DC Motors
> Lithonomy, Cardiac and Bed Positions

> Fixed Floor Surface With Artificial Leather
Covering Consisting of 3 Parts.

> Easy to Use With Hand Control

> Metal Parts Are Electrostatic Powder Coated

Seamed Jinekolojik
Muayene Masasi the potentia
Seamed Gynecological Examination Table

» Tamamen Celik Konstriiksiyondan Imalat
> 2 Motorlu Sirt Ayari, 1 Motorlu YUkseklik Ayart
> Kumanda ile Yikseklik ve Sirt Ayar

> Suni Deriden Uretilmis Yatma Yiizeyi

> Elektrostatik Toz Boya Kaplama

> Manufacture From Completely Steel Construction

> 2 Motorized Back Adjustment, 1 Motorized Height Adjustment
» Height and Back Adjustment With Remote Control

> Lying Surface Made of Artificial Leather

> Electrostatic Powder Paint Coating

SeaMed

46



S DENIZLER
12) meDikAL
SeaMed Wi-Fi Konveks

Mobil Ultrason Cihazi
SeaMed Wi-Fi Convex Mobile Ultrasound Device

> Telefon/Tablet ile Kullanim Imkani
> Hafif ve Kompakt Tasarim - = - —
> Renkli Doppler Ozellikli

> B, B/M, PW ve PDI Gorintileme

> Possibility of Use With Phone/Tablet Computer ' -@g

> Lightweight and Compact Design
> Color Doppler Feature

®
> B, B/M, PW and PDI Imaging SeaMed

SonoScape

Ultrason Cihazi
SonoScape Ultrasound Device

> Renkli Dokunmatik LCD Ekran
> Super Genis Bant Genisligi Platformu
> Yiksek Cozinidrllikte Gorintileme

> 4D Tani Teknolojisi

> Color Touchscreen LCD Screen
> Super Wide Bandwidth Platform
> High Resolution Display

> 4D Diagnostic Technology

SonoScape

www.denizlermedikal.com



Dr.Oppel ST-501 Radyofrekans

Elektrokoter Cihazi
Dr.Oppel ST-501 Radiofrequency

Electrocautery Device

> 4 Mhz Radyo Frekans Akimi ile Hassas Kesme ve Koagllasyon
> Cevresel Dokularda Minimal Hasar s : e
» Zaman Secimi: Strekli, Isn, 1/2sn, 1/4sn, 1/8sn /“-) O
» Monopolar Calisma Guct: 130 W
> Bipolar Calisma Gtict: 90 W

» Precise Cutting and Coagulation with 4 Mhz Radio Frequency @8
> Minimal Damage to Peripheral Tissues
» Time Selection: Continuous, 1sec, 1/2sec, 1/4sec, 1/8sec

» Monopolar Operating Power: 130 W
nppel

> Bipolar Operating Power: 90 W

SeaMed Fetal Doppler
SeaMed Fetal Doppler :

> Elde Tasinabilir Kompakt ve Hafif Dizayn

> Gergek Zamanli Fetal Nabiz Algilayabilme

» Arkadan Aydinlatmali Genis LCD Ekran

> Yiksek Hassasiyetli 2 MHZz' lik Ultrason Probu
> Pil Sarj Gostergeli

> Handheld Compact and Lightweight Design

> Real Time Fetal Pulse Detection

> Large Backlit LCD Display
> High Sensitivity 2 MHz Ultrasound Probe
> With Battery Charge Indicator

SeaMed
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SeaMed Suda Dogum Havuzu
SeaMed Water Birth Pool

> 6P-PVC Kalitesinde YUksek Dayanikli ve Saglikli Malzeme
> 6 Adet Tutma Kollu
> Dahili Su ve Hava Pompasi

> Profesyonel Kullanima Uygun

> High Durable and Healthy Material in 6P-PVC Quality
> 6 pcs. Handles
> Internal Water and Air Pump

> Suitable for Professional Use

SeaMed

www.denizlermedikal.com




Anahtar Teslim
Acil Servis Unitesi

Turnkey Emergency Service Unit

Discover
the potential
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SeaMed Kapnometre Cihazi SeaMed’
SeaMed Capnometer Device

> Yenidogan, Cocuk ve Yetiskin > Use in Neonatal, Child and
Hastalarda Kullanabilme Adult Patients e
> EtCO,/CO,, Solunum > EtCO, / CO,, Ability to \ 5 > -
Parametrelerini Izleyebilme Monitor Respiratory Parameters \\ )\
> EtCO, Parametrelerini Grafiksel > Graphically Monitoring EtCO, ( o :
Olarak izleyebilme Parameters = N )
. P("‘ > (:';-} // =
> Sesli ve Gorsel Alarmlar > Audible and Visual Alarms ( \\ =4 ‘
> Opsiyonel USB Portu ile Bilgisayara » pata Transfer to Computer with \\‘1// y
Data Aktarimi Optional USB Port

SeaMed NC-5 Vital Monitor
SeaMed NC-5 Vital Monitor

> 8" Renkli Dokunmatik TFT > 8" Color Touchscreen TFT
LCD Ekran LCD Display

> EKG, SpO,,, PR, NIBP, Solunum Ve » Monitoring ECG, SpO,, PR, NIBP,

Ciltten Isi Parametrelerini Izleyebilme ~ Respiratory and Skin Temperature

ye &

> Ates Olcer Kullanim imkani Parameters T H ..!
> Yenidogan/Pediatrik/Yetiskin > Thermometer Usage Opportunity
Kullanim Modlar > Neonatal/Pediatric/Adult Use Modes

-
=

> Tekerlekli ve Sepetli Tasima Sehpasi  » Carrying Stand with Wheels and Baskets

=~
> Kablolu veya Kablosuz Veri > Ability to Transfer Wired or Wireless Data ,- 3 ~
Aktarimi Yapabilme [;F\

SeaMed PC-900B Kapnograf & SpO:, Cihazi _
SeaMed PC-900B Capnograph & SpO. ,Device

> Renkli TFT LCD Ekran > Color TFT LCD Screen
|

> Yenidogan, Cocuk Ve Yetiskin > Use in Neonatal, Child and !

Hastalarda Kullanabilme Adult Patients |
> EtCO,, Solunum ve SpO,, > Monitoring EtCO,, Respiratory

Parametrelerini izleyebilme and SpO, Parameters
» EtCO, Grafiksel Olarak Izleyebilme 3 Graphically Monitoring EtCO,
» 10 Saat Kadar Batarya Suresi » Up to 10 Hours of Battery Time
> Sesli ve Gorsel Alarmlar > Audible and Visual Alarms S

www.denizlermedikal.com




SeaMed H12 EKG Cihazi
SeaMed H12 ECG Device

> 10" Dokunmatik LCD Ekran
> Otomatik Aritmi Tespiti ve Raporu
> DICOM, BMP, JPG,PDF,SCP-ECG,FDA-XML Formatlarinda Raporlama

> Hastane Bilgi Yonetim Sistemine Baglanabilme

> 10" Touchscreen LCD Screen

> Automatic Arrhythmia Detection and Report

> Reporting in DICOM, BMP, JPG, PDF, SCP-ECG, FDA-XML Formats

> Connecting to the Hospital Information Management System

SeaMed S8

Defibrilator Cihazi
SeaMed S8 Defibrillator Device

> 84" TFT-LCD Renkli Ekran

> Pediatrik ve Yetiskin Hastalarda Kullanim imkan
> 1-360 Joule Arasi Enerji Secimi

> Bataryasl ile 6 Saate Kadar Kullanabilme

» Opsiyonel SpO, / EtCO, / NIBP Ozellikli

> 84" TFT-LCD Color Screen
> Possibility of Use in Pediatric and Adult Patients

> Energy Selection Between [-360 Joules

> Use up to 6 Hours With its Battery
> Optional SpO, / EtCO, / NIBP Features

SeaMed
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[ISM Damar

Goruntileme Cihazi
ISM Vein Imaging Device

> Renkli Dokunmatik LCD Ekran
> Non-Invaziv KizilStesi Teknoloji
> Dahili Batarya ile Kullanim Imkani
> Otomatik Parlaklik Ayar

> Color Touchscreen LCD Display

> Non-invasive Infrared Technology

> Possibility of Use With Internal Battery .'w
> Automatic Brightness Adjustment ”

Transport Ventilator Cihazi
Transport Ventilator Device

> Renkli Dokunmatik LCD Ekran

> Yetiskin ve Pediatrik Hastalarda Kullanima Uygun
> Dahili Batarya ile Kullanm

> %21-%100 Oksijen Ayarlamasi

> Color Touchscreen LCD Display

> Suitable For Use In Adult and Pediatric Patients

> Use With Internal Battery
> 21%-100% Oxygen Adjustment

Discover
the potential
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Acil Mudahale Sedyesi

Emergency Stretcher

> Avarlanabilir Yukseklik, Trendelenburg Pozisyonlari

> 2 Adet Metal Kilitlenebilen, Gizlenebilen Yan Korkuluklar

> Plastik Koruyucu Carpma Tamponlari
> Elektrostatik Toz Boya

> Sivi Gegirmez Silte

> Adjustable Height, Trendelenburg Positions
> 2 pcs. Metal Lockable, Concealable Side Rails

e
> Plastic Protective Crash Bumpers N ;‘? - %
> Electrostatic Powder Paint N & »
> Liquid Proof Mattress B 2}'—. . \

Acil Midahale Arabasi
Crash Cart

> Paslanmaz Metal Govdeli

> 3 Kuglk, 1 Orta ve 1 Blylk Cekmeceli

> Cekmecelerin Ici Istege Gére Ayarlanabilir Bdimeli
> Defibrilatér/Monitor Sehpasi

> Resusitasyon(Cpr) Tahtas

> Kilitlenebilir Tekerlekler

> Stainless Metal Body

> 3 pcs. Small, 1 pc. Medium and 1 pc. Large Drawers
> The Inside of the Drawers is Optionally Adjustable
> Defibrillator/Monitor Stand

> Resuscitation (Cpr) Board

> Lockable Wheels
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SeaMed Laringoskop
SeaMed Laryngoscope

Hastalarda Guvenilir Kullanim

Kapali Fiberoptik Sistem

Kolay Ampul ve Pil Degisimi

| 34°C Sicaklikta Otoklavlanabilir Bladeler
Miller-Macintosh Bladeler

Opsiyonel Handle Sarj Cihazi

v V VvV VvV VvV VvV Vv

Paslanmaz Celik Yapi

> Reliable Use in Patients

> Maxilite Fiberoptic System

» Easy Bulb and Battery Change

» Autoclavable Blades at 134°C Temperature
> Miller-Macintosh Blades

> Optional Handle Charger

> Stainless Steel Structure

SeaMed Otoskop-OFftalmaskop
SeaMed Otoscope-Ophthalmoscope

> 4 Metrelik Spiral Kablo ile Kullanim Imkani
% Elcekler Uzerinden lsik Siddeti Ayarlayabilme
> Her Iki Elcegi Ayni Anda Kullanabilme wa

» Otoskop icin Spekulum Kutulu

> Possibility of Use With a Spiral Cable of 4 Meters
> Adjusting the Intensity of Light on the Handsets

> Ability to Use Both Hands at the Same Time

> With Speculum Box for Otoscope

SeaMed

www.denizlermedikal.com
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Gogus Hastaliklari Servisi

Turnkey Pulmonary Medicine Department
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MeHow LA-104 Konsol Tipi

Spirometre Cihazi
MeHow LA-104 Console Type Spirometer Device

> Cift islemci ile Daha Hizli Olctim > Faster Measurement with Dual Processors
» Renkli Dokunmatik LCD Ekran » Color Touchscreen LCD Display

» Dahili Batarya ve Yazicl Destegi > Internal Battery and Printer Support

> USB Destegi ile Baglanti > Connection with USB Support

MEeHow

www.denizlermedikal.com




MEHow

MeHow LA-204 El Tipi

Spirometre Cihazi
MeHow LA-204 Hand Held Spirometer Device

> Dijital Turbin Sensérii ile Dogrulugu Arttinlmis Olctim
> Renkli LCD Izleme Ekran

> Bluetooth ile Telefona Baglanabilme Ozellisi

> Sarj Edilebilir Lityum Batarya

> 0-16 /S Akis Skalas

> Accurate Measurement With Digital Turbine Sensor
> Color LCD Monitoring Screen

> Ability to Connect to Phone via Bluetooth

> Rechargeable Lithium Battery

> 0-16 L/S Flow Scale

MeHow LA-303

Spirometre Cihazi
MeHow LA-303 Spirometer Device

> Dijital Turbin Sensorii ile Dogrulugu Arttinlmis Olclim
» USB ile Bilgisayara Baglanabilme Ozellisi

> Yetiskin ve Pediatrik Hastalarda Kullanim

> 0-16 LJS Akis Skalas

> Accurate Measurement with Digital Turbine Sensor
> Ability to Connect to Computer Via USB

> Use in Adult and Pediatric Patients

> 0-16 L/S Flow Scale
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Cheiron Toraks Drenaj Cihazi %
Cheiron Thorax Drainage Device Cheiron
> Toraks Drenaj Islemlerde Sessiz ve Titresimsiz Calisma Imkani
> Ciftli Toraks Regllatort ile Kullanim
> Dakikada 6 Defa Aralikli Cekim

39,4 dB Ses Seviyesi

Mikrobiyolojik Bakteri Filtresi

>

>

> Asin Akis Koruma Sistemi

> Surekli Calismaya Uygun Tasarim
>

Isinmaya Karsi Ekstra Fan ile Sogutma

> Quiet and Vibration-Free Operation Opportunity in Thorax

Drainage Procedures

Use With Dual Thorax Regulator

Intermittent Shooting 6 Times a Minute

39.4 dB Sound Level

Microbiological Bacteria Filter é —
Overflow Protection System o

Design Suitable for Continuous Operation

v VvV VvV VvV VvV Vv

» Cooling With Extra Fan Against Heating

SeaMed H12 EKG Cihazi
SeaMed H12 ECG Device

> 10" Dokunmatik LCD Ekran
> Otomatik Aritmi Tespiti ve Raporu
> DICOM, BMP, JPG,PDF,SCP-ECG,FDA-XML Formatlarinda Raporlama

> Hastane Bilgi Yonetim Sistemine Baglanabilme

> 10" Touchscreen LCD Screen
> Automatic Arrhythmia Detection and Report
> Reporting in DICOM, BMP, |PG, PDF, SCP-ECG, FDA-XML Formats

> Connecting to The Hospital Information Management System

www.denizlermedikal.com




Anahtar Teslim
Dis Poliklinigi

Turnkey Dental Clinic

EET
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Dental Unit 2

> Sirtlk ve Ayakligin Hastayl Rahatsiz Etmeden Senkronize Hareketi
> 24V DC Motorlar ile Amortisér Sistemi

> Acil Durumlarda Koltuk Alti Ve Asistan Kolunda Otomatik Stop Butonu = "7
> Doktorun Rahatca Calisabilecegi Genis Tabla ‘

> Pnédmatik Fren Sistemi

> Koltuga Monte 90° Donebilen
Otoklavlanabilir Cam Canakli Kresua

¥ Zamanlanabilir ve Otoklavlanabilir Bardak Doldurucu
ve Canak Yikayici

> Dogal Gin Isigina Yakin Soguk Isik
> Su ve Dezenfektan Deposu

> Synchronized Movement of Backrest and Footrest Without
Disturbing the Patient

> Shock Absorber System With 24 V DC Motors

> Automatic Stop Button on Under the Seat and Assistant's Arm in Emergency Situations
> Wide Table Where the Doctor Can Work Comfortably

> Pneumatic Brake System Offering Ease of Working to the Physician

> Seat Mounted 90° Rotating Autoclavable Glass Bow!l Cresau

> Timed And Autoclavable Cup Filler And Dish Washer

> Cold Light Near Natural Daylight

> Water and Disinfectant Tank

Panoromik Dis Rontgeni
Panoramic Dental X-Ray

> Otomatik Fokuslama Teknolojisi

> Panoromik / 3D / Sefalometrik (Opsiyonel) Sistem

> 12 Ayn Cekim Modu

> Panoramik Cekim Modlari
Standart / Sag / On / Sol
Bitewing Standart / Sag / On / Sol
Orthogonal Standart / Sag / On / Sol

> Ozel Cekim Modlan > Auto Focus Technology
TMJLAT (Agik-Kapali ) / Sints PA » Panoramic / 3D / Cephalometric (Optional) System
TM PA (Acik-Kapali) / Sints LAT (Opsiyonel) > 12 pcs. Different Shooting Modes

> Panoramic Shooting Modes
Standard / Right / Front / Left
Bitewing Standard / Right / Front / Left
Orthogonal Standard / Right / Front / Left

Discover N ' :
the potential Special Shooting Modes

TMJ LAT (On-Off) / Sine PA
TM) PA (On-Off) / Sine LAT (Optional)

www.denizlermedikal.com




Anahtar Teslim
KBB Poliklinigi

Turnkey ENT Polyclinic
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KBB Muayene Unitesi
ENT Examination Unit

> Full HD Endoskopik Kamera > Full HD Endoscopic Camera
> Dahili Aspirator Sistemi > Internal Aspirator System
> Farkli Boylarda Malzeme Cekmeceleri > Material Drawers in Different Sizes
> LCD Kontrol Paneli > LCD Control Panel
= o

¢y
gz%y_ 8 x'

Discover
the potential

www.denizlermedikal.com




Dr.Oppel ST-501 Radyofrekans

Elektrokoter Cihazi
Dr. Oppel ST-501 Radiofrequency

Electrocautery Device

> 4 Mhz Radyo Frekans Akimi ile Hassas Kesme ve Koagtlasyon
> Cevresel Dokularda Minimal Hasar

> Zaman Secimi: Strekli, 1sn, 1/2sn, 1/4sn, 1/8sn
> Monopolar Calisma Guct: 130 W

> Bipolar Calisma Guct: 90 W

> Precise Cutting and Coagulation with
4 Mhz Radio Frequency Current

> Minimal Damage to Peripheral Tissues

> Time Selection: Continuous, 1sec, 1/2sec, 1/4sec, 1/8sec

> Monopolar Operating Power: 130 W D O p p e I

> Bipolar Operating Power: 90 W

SeaMed Duvara Monte Otoskop
SeaMed Wall Mounted Otoscope

-

> Ultraviyoleden Anindiriimis Aydinlatma
> Pnématik Kulak Test Imkani

¥ Elcek Uzerinden Isik Siddet Ayari

> 4 Bolmeli Spekulum Kutusu

> UV - Free Lighting
> Pneumatic Ear Testing Facility
> Light Intensity Adjustment Via Handle

> 4 Parts Speculum Box

SeaMecd
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Yiksek Frekans Odyometre
High Frequency Audiometer

> Hava Yoluyla lletim, Kemik Yoluyla lletim, Serbest Alan
ve Konusma Odyometresi Testleri

> Pure Ton, Pulse Ton, Warble Ton, Dar Bant, Beyaz ve

Konusma GurGltusd &
> 20000HZ'e Kadar YUksek Ses Secenegi = ,
> SD Hafiza Karti, CD veya Mikrofondan Konusma Testler . \'L\ (]
> Air Conduction, Bone Conduction, Free Field and Speech Audiometry Tests —

> Pure Tone, Pulse Tone, Warble Tone, Narrowband, White and Speech Noise
> Up to 20000Hz Loud Sound Option
> Speech Tests From SD Memory Card, CD or Microphone

Multi Frekans Timpanometre
Multi Frequency Tympanometer

> LCD Ekranda Timpanogram ve > Tympanogram and Test Results
Test Sonuclan Gorintisu Display on the LCD Screen
> Hizli ve Sessiz Termal Yazic > Fast and Quiet Thermal Printer —— y
» Ipsi ve Kontralateral Reflex Testlerinde 3 Pure Sound and Noise Signal in \-
Saf Ses ve GUrlltd Sinyali Ipsi and Contralateral Reflex Tests

» Avyarlanabilir Basing Araligi ve Basing Hizi » Adjustable Pressure Range and Pressure Speed
» Coklu Frekans Probu > Multi-Frequency Probe

Yenidogan Isitme Tarama Cihazi
Neonatal Hearing Screening Device

> Hizl ve Otomatik ABR Gorintileme

> Deriye Direkt Kontakt ile Otomatik Empedans Ayari
> Fonksiyonel Data Ciktisi ve Takibi

> Uyanm Ses Seviyesi 35 dB NHL

> USB Baglantisi Sayesinde Data Transferi Imkan

> Fast and Automatic ABR imaging
> Automatic Impedance Adjustment With Direct Skin Contact

> Functional Data Output and Monitoing
> Warning Volume 35 dB NHL
> Data Transfer Facility to USB Connection

www.denizlermedikal.com




Anahtar Teslim
Hasta Servis Odalari

Turnkey Patient Service Rooms

Discover
the potential
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SeaMed NC-5
Vital Monitor =
SeaMed NC-5 Vital Monitor

> 8" Renkli Dokunmatik TFT LCD Ekran —

> EKG, SpO,, PR, NIBP, Solunum ve Ciltten Isi
Parametrelerini Izleyebilme

> Ates Olcer Kullanim Imkani
> Yenidogan/Pediatrik/Yetiskin Kullanim Modlan

> Tekerlekli ve Sepetli Tasima Sehpasi

> Kablolu veya Kablosuz Veri Aktarimi Yapabilme

> 8" Color Touchscreen TFT LCD Display :h -
"\\
> Monitoring ECG, SpO,, PR, NIBP, Respiratory and Skin Temperature Parameters F
> Thermometer Usage Opportunity
> Neonatal/Pediatric/Adult Use Modes
> Trolley With Wheels and Basket
e

> Ability to Transfer Wired or Wireless Data

SeaMed XM-550 Hastabasi Monitori
SeaMed XM-550 Patient Monitor

> EKG, NIBP, RESP, PR, SpO, , TEMP ve 2xIBP Parametreleri
> 10.4" veya 12.1” Renkli TFT LCD Ekran

> 3 Seviyeli Sesli ve Gorsel Alarm
> Dahili 6 Saate Kadar Batarya
> Opsiyonel Merkezi Monitér Sistem Baglantisi

> Opsiyonel EtCO, (Kapnograf) Parametresi

> ECG, NIBP, RESP, PR, SpO,, TEMP and 2xIBP Parameters
> 10.4" or 12.1" Color TFT LCD Display

> 3 Level Audible and Visual Alarm

> Up to 6 Hours Built-in Battery

> Optional Central Monitoring System Connection
> Optional EtCO, (Capnograph) Parameter

www.denizlermedikal.com



SeaMed H12 EKG Cihaz
SeaMed H12 ECG Device

> 10" Dokunmatik LCD Ekran
> Otomatik Aritmi Tespiti ve Raporu
> DICOM, BMP, JPG,PDF,SCP-ECG,FDA-XML Formatlarinda Raporlama

> Hastane Bilgi Yonetim Sistemine Baglanabilme

> 10" Touchscreen LCD Screen

> Automatic Arrhythmia Detection and Report

> Reporting in DICOM, BMP, |PG, PDF, SCP-ECG, FDA-XML Formats

> Connecting to the Hospital Information Management System

SeaMed S8

Defibrilator Cihazi
SeaMed S8 Defibrillator Device

> 84" TFT-LCD Renkli Ekran

> Pediatrik ve Yetiskin Hastalarda Kullanim imkani
> 1-360 Joule Arasi Enerji Secimi

> Bataryasl ile 6 Saate Kadar Kullanabilme

» Opsiyonel SpO, / EtCO, / NIBP Ozellikli

> 84" TFT-LCD Color Screen
> Possibility of Use in Pediatric and Adult Patients

> Energy Selection Between [-360 Joules

> Use up to 6 Hours With its Battery
> Optional SpO, / EtCO, / NIBP Features

SeaMed
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Acil Miidahale Arabasi

Crash Cart

T Y o I <&

> Paslanmaz Metal Govdeli

> 3 Kuglk, 1 Orta ve 1 BuyUk Cekmeceli
> Cekmecelerin ici Istege Gére Ayarlanabilir Bsimeli |
> Defibrilatér/Monitér Sehpasi
> Resusitasyon(Cpr) Tahtasi

> Kilitlenebilir Tekerlekler

> Stainless Metal Body

> 3 pcs. Small, 1 pc. Medium and 1 pc. Large Drawers
> The Inside of The Drawers is Optionally Adjustable.
> Defibrillator/Monitor Stand —_
o %J%ﬁ
> Resuscitation (Cpr) Board A EEL B

> Lockable Wheels Discover
the potential

SeaMed Hasta Yatagi
SeaMed Patient Bed

> Kolay Temizlenebilir Hijyenik Doku

> UV ve Glnes Isinlarina Dayanikli Koruma
Tabakasina Sahip Ozel Plastik Malzeme

> Bl Kumandas! ile Kolay Kontrol imkani _) ‘
» Elektrik Kesintisine Karsi Batarya Destek Unitesi \

> Easy to Clean Hygienic Texture

> Special Plastic Material With UV and
Sunlight Resistant Protection Layer

> Easy to Control With Remote Control

» Battery Support Unit Againist Power Failure

www.denizlermedikal.com




Teshis / Tani Cihazlari

Diagnostic Devices

70



5 e
Covidien El Tipi
Pulseoksimetre
Covidien Handheld Pulseoximeter

> Renkli TFT LCD Ekran

> Yetiskin, Pediatrik, Yenidogan Hastalarda Kullanim
> Hizli ve Guvenilir Olciimleme
> Sesli ve Gorsel Alarmlar

> Dahili Batarya ile Kullanim

> Color TFT LCD Display
> Use in Adult, Pediatric, Neonatal Patients
> Fast and Reliable Measurement

> Audible and Visual Alarms

> Use With Built-in Battery ﬂ COVIDIEN

Covidien Konsol Tipi

Pulseoksimetre
Covidien Console Type Pulseoximeter

> Renkli TFT LCD Ekran

> Yetiskin, Pediatrik, Yenidogan Hastalarda Kullanim
> Hizli ve Guvenilir Olciimleme

> Sesli ve Gorsel Alarmlar

> Dahili Batarya Ile Kullanim

> Color TFT LCD Display

> Use in Adult, Pediatric, Neonatal Patients
> Fast and Reliable Measurement

> Audible and Visual Alarms

> Use with Built-in Battery

www.denizlermedikal.com




SeaMed SP20 El Tipi Pulseoksimetre
SeaMed SP20 Handheld Pulseoximeter

> Renkli TFT LCD Ekran > Color TFT LCD Display

> Yetiskin, Pediatrik, Yenidogan > Use in Adult, Pediatric,
Hastalarda Kullanim Neonatal Patients

» Hizli ve Guvenilir Olctimleme > Fast and Reliable Measurement

» Sesli ve Gorsel Alarmlar » Audible and Visual Alarms

> Farkli Ekran Goriinttleme Modlar > Different Screen Display Modes

> 18 Saate Kadar Batarya ile Kullanim > Up to 18 Hours of Battery Use
> Opsiyonel olarak Kulaktan Ates Olcer ~ » Optional Ear Thermometer

SeaMed Pediatrik Parmak Tipi Pulseoksimetre

SeaMed Pediatric Finger Type Pulseoximeter

» SpO, ve Nabiz Sayisi Degerlerinin Dogru Olciimd

> Renkli Ekranda SpO,, Nabiz Sayisi, Pl, Kalp Ritmi ve Pletismogram Goriintisu
> 4 Farkli Ekran Gorinttleme Modu

» Parmaga Yerlestirildikten Sonra Otomatik Olctim Baslangici

> 4 Saniye Sinyal AlImadigi Takdirde Otomatik Sinyal Kapama

> 2 AAA Pil ile 30 Saatten Fazla Strekli Calisma Stresi

> Gorsel ve Isitsel Alarmlar

> Accurate Measurement of SpO, and Pulse Rate Values

> SpO,, Pulse Rate, Pl, Heart Rate and Plethysmogram Display on Color Screen
> 4 pcs. Different Screen Display Modes

> Automatic Start of Measurement After Placement on Finger

> Automatic Signal Off After 4 Seconds No Signal

> More than 30 Hours of Continuous Working Time With 2 pcs. AAA Batteries
> Visual and Audible Alarms

SeaMed Yetiskin Parmak Tipi Pulseoksimetre

SeaMed Adult Finger Type Pulseoximeter

> Renkli OLED Ekran > Color OLED Display
> Hizli ve Guvenilir Olctimleme > Fast and Reliable Measurement
> Sesli ve Gorsel Alarmlar > Audible and Visual Alarms

> 4 Farkli Ekran Goruntileme Modu ¥ 4 pcs. Different Screen Display Modes
» Otomatik Gi¢ Agma/Kapama > Auto Power On/Off
» 50 Saate Kadar Calisma Imkan > Opportunity to Work up to 50 Hours

SeaMed
72
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SeaMed Duvara Monte Tansiyon Aleti
SeaMed Wall-Mounted Sphygmomanometer

> Kolayca Okunabilen Gosterge Ekrani

» 0-300 mmHg Olctim Skalas|

> Ustten Kizakli ve Gegirmeli Tipte Kolay Montaj Aparati
> 3 Metreye Kadar Uzayabilen Spiral Hortum

> Cwa Icermeyen Saglikli Dizayn

> Easily Readable Display Screen

> 0-300 mmHg Measurement Scale

> Easy Mounting Apparatus With Top Slide and Plug-in Type
> Spiral Hose That can be Extended up to 3 Meters

> Mercury Free Healthy Design

SeaMed Pediatrik Tansiyon Aleti

SeaMed Pediatric Sphygmomanometer

> Nikel Kaplama ve Kromajlanmis Manometre Haznesi
» 0-300 mmHg Olciim Skalas|

> Kolayca Sisirilebilen, Esnek Manson

> Guvenlikli, Sabitlenmis Hava Muslugu Vidasi

> Nickel Coating and Chrome Coating Manometer Chamber
> 0-300 mmHg Measurement Scale

> Easily Inflated, Flexible Cuff

> Safe, Fixed Air Cock Screw

SeaMed Yetiskin Tansiyon Aleti
SeaMed Adult Sphygmomanometer

> Nikel Kaplama ve Kromajlanmis Manometre Haznesi
» 0-300 mmHg Olciim Skalas|

> Kolayca Sisirilebilen, Esnek Manson

> Guvenlikli, Sabitlenmis Hava Muslugu Vidasi

> Nickel Coating and Chrome Coating Manometer Chamber
> 0-300 mmHg Measurement Scale

> Easily Inflated, Flexible Cuff

> Safe, Fixed Air Cock Screw

SeaMed 73|




SeaMed Pediatrik

Stetoskop
SeaMed Pediatric Stethoscope

Paslanmaz Celikten Uretilmis Baslik

Frekans Tepkisi icin Ekstra Blytk Can

Net Yiksek Frekans Tepkisi Icin Ultra Hassas Diyafram
Ustiin Kullanim Rahatligi ve Akustik Conta

PVC Kulak Uclan

v VvV VvV VvV Vv

Head Made of Stainless Steel
Extra Large Bell for Frequency Response
Ultra Sensitive Diaphragm for Clear High Frequency Response

Superior Easy of Use and Acoustic Gasket

v VvV VvV VvV Vv

PVC Ear Mushrooms

SeaMed Yetiskin

Stetoskop
SeaMed Adult Stethoscope

Paslanmaz Celikten Uretilmis Baslik

Frekans Tepkisi icin Ekstra Buyik Can

Net Yiksek Frekans Tepkisi icin Ultra Hassas Diyafram
Ustiin Kullanim Rahatlig ve Akustik Conta

PVC Kulak Uclan

v VvV VvV VvV Vv

Head Made of Stainless Steel

Extra Large Bell for Frequency Response

Ultra Sensitive Diaphragm for Clear High Frequency Response
Superior Easy of Use and Acoustic Gasket

PVC Ear Mushrooms

v VvV VvV VvV Vv
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SeaMed Yenidogan (Miller)

Laringoskop

SeaMed Neonatal (Miller) Laryngoscope

> Hastalarda Guvenilir Kullanim

> Kapali Fiberoptik Sistem

> Kolay Ampul ve Pil Degisimi

> 134°C Sicaklikta Otoklavlanabilir Bladeler
> Opsiyonel Handle Sarj Cihazi

> Paslanmaz Celik Yapi

SeaMed Yetiskin (Macintosh)

Laringoskop

SeaMed Adult (Macintosh) Laryngoscope

> Hastalarda Guvenilir Kullanim
> Kapali Fiberoptik Sistem
> Kolay Ampul ve Pil Degisimi

> 134°C Sicaklikta Otoklavlanabilir
Bladeler

> Opsiyonel Handle Sarj Cihazi
> Paslanmaz Celik Yapi

> Reliable Use in Patients
> Maxilite Fiberoptic System
> Easy to Change For Bulb and Battery

> Autoclavable Blades at 134°C
Temperature

> Optional Handle Charger
> Stainless Steel

DENIZLER
MEDIKAL

> Reliable Use in Patients
> Maxilite Fiberoptic System

> Easy to Change For Bulb and Battery

> Autoclavable Blades at 34°C
Temperature

> Optional Handle Charger
> Stainless Steel

SeaMed Zor Entiibasyon (McCoy)

Laringoskop

SeaMed Difficult Intubation (McCoy)

Laryngoscope

> Hastalarda Guvenilir Kullanim
> 70° Kivrilabilir Blade Ucu

> Kapali Fiberoptik Sistem

> Kolay Ampul ve Pil Degisimi

> 134°C Sicaklikta Otoklavlanabilir
Bladeler

> Opsiyonel Handle Sarj Cihazi

> Paslanmaz Celik Yapi

www.denizlermedikal.com

> Reliable Use in Patients

> 70° Flexible Blade Tip

> Maxilite Fiberoptic System
> Easy to Change For Bulb and Battery

» Autoclavable Blades at 134°C
Temperature

> Optional Handle Charger
> Stainless Steel




SeaMed Duvara Monte
Oftalmaskop

SeaMed Wall Mounted Ophthalmoscope

> Ultraviyoleden Arinmis Aydinlatma
¥ Elimine Edilmis Kornea ve Iris Refleksiyonlar
> Eseli 6 Ayn Goriiniim Imkani

> Yildizli Koordinat Sistemi, BuyUk-Kucuk Daire,
Yarim Daire,Grid,Stenopaik Slit

> 3 Farkli Isik Modu ( Beyaz, Mavi, Yesil )
> Elcek Uzerinden lsik Siddeti Ayarlayabilme

> UV - Free Lighting
> Eliminated Corneal and Iris Reflections
> Possibility of 6 pcs. Different Views With Pairs

> Star Coordinate System, Great-Small Circle,
Half Circle, Grid, Stenopaic Slit

> 3 pcs. Different Light Modes (White, Blue, Green)
> Ability to Adjust the Light Intensity Via the Handle

SeaMed Duvara Monte

Otoskop
SeaMed Wall Mounted Otoscope

> Ultraviyoleden Anindiriimis Aydinlatma
> Pndmatik Kulak Test Imkani

> Elcek Uzerinden Isik Siddet Ayari

> 4 Bolmeli Spekulum Kutusu

> UV - Free Lighting
> Pneumatic Ear Testing Facility
> Light Intensity Adjustment Via Handle

> 4 Parts Speculum Box
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SeaMed Diagnostik Set
SeaMed Diagnostic Set

> Isig1 Ayarlanabilir Handle

> C Boy Pil ile Kullanim

> Set icerisinde;
1 adet Otoskop
1 adet Oftalmoskop
2 adet Larenks Aynasi (3 ve 4 Ebatlarinda)
3 adet Kulak Spekulumu (2,57 3,5 /4,5 mm Ebatlarinda)
1 adet Isik Tutacags (Larenks Aynalarn Icin)

1 adet Burun Spekulumu (Reusable)

> Light Adjustable Handle
> Use with C Size Battery
> In the set;
1 pc. Otoscope
1 pc. Ophthalmoscope
2 pcs. Laryngeal Mirrors (Sizes 3 and 4)
3 pcs. Ear Speculum (2.5 /3.5 /4.5 mm Sizes)
1 pc. Light Holder (For Laryngeal Mirrors)
1 pc. Nasal Speculum (Reusable)

SeaMed Spekulum

SeaMed Speculum

> Hicbir Alerjik Reaksiyon Gostermeyen » PVC Material Does Not Show

PVC Malzeme Any Allergic Reactions
> Capaksiz ve Purlzsiz Bir Yapi > A Burr-Free and Smooth Structure
> Net Gorlst Engellemez > Does Not Black Obstruct Clear View
> Tek Kullanimlik > Disposable
> Isik Kaybini Azaltan Siyahlik > Blackness that Reduces Light Loss
> 2.5 mm ve 4 mm Cap > 2.5 mm and 4 mm Diameter

www.denizlermedikal.com



Dijital Ameliyathane
Bilgi YOonetim Sistemi

Digital Operating Room
Information Management System

Discover
the potential
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Ameliyathane Bilgi Yoénetim Sistemi, saglik meslek mensuplaninin bireysel yetkilendirme sonrasinda hasta dosyalarina
kendi gbsterge tablolarindan erismelerini ve takip etmelerini, uyan notlan, alerji, kronik hastaliklar gibi bilgileri takip
etmelerini saglayan yeni nesil dijital klinik bilgi sistemi platformudur. ICD 10 gibi tani kodlarini ekleyerek kan grubu, yas,
cinsiyet, hasta yakinlari, yer ve kalis sUresi gibi verilere eriserek QR kod, barkod, RF-ID ve NFC gibi kablosuz teknolojileri
kullanarak sahip olduklan bilgileri dogrulayabilmektedir.

Bu WEB tabanli sistem, HBYS (Hastane Bilgi Yonetim Sistemi) sistemleri ve hastanin bulundugu yerde veri aktarabilen
tim tibbi cihazlarla entegre olabilmektedir. Sistem bu cihazlardan stirekli olarak glincel hasta verilerini alir. Hasta
lokasyonunda bulunan tim kagit formlanin tablet bilgisayarlar Uzerinden dijital ortama aktanimasini saglamaktadir.

Ameliyat Gecmisi, Doz Periyodu, Svi Periyodu, Bolus ve metod bazli ilag uygulama kayitlan sistem Uzerinden
izlenebilmektedir. Anestezi llac seti tanimlama ve uygulama islemleri, olay - bulma - gézlem - midahale takipler,
ventilator seti tanimlama ve uygulamalari ile tim operasyon sireci dijital ortamda anlik olarak kayit altina alinmaktadir.
Adim adim kayrt giris altyapisi sayesinde glvenli cerrahi formlar, anestezi takip formlan gibi zorunlu formlar dijital
ortamda kolaylikla kayit altina alinmaktadir.

BUtln parametreler ve olaylar entegre edilen cihazlarda zaman etiketi eklenerek dogru sirada kaydedilmektedir. Hasta
sisteme bagli cihazlarla ameliyathaneden cikarsa bu bilgiler de sistemde saklanmaktadir. HBYS entegrasyonu ile hasta
demografik bilgileri alinmakta ve hastanin gilincel laboratuvar verileri grafiksel ve sayisal olarak gorintilenebilmektedir.

Klinik fotograflama &zelligi sayesinde aktif islem bazli kayitlar etiketlenebilir, bu etiketlere notlar eklenebilir ve
llgili kullanicilar bu notlan yorumlayabilir.

Operating Room Information Management System is a new generation digital clinical information system platform that
enables healthcare professionals to access and follow patient files from their own dashboards after individual
authorization and to monitor information such as waming notes, allergies, chronic diseases. By adding diagnostic codes
such as ICD 10, they can access data such as blood group, age, gender, patient relatives, location and length of stay and
verify their information using wireless technologies such as QR code, barcode, RF-ID and NFC

This WEB-based system can be integrated with HBYS (Hospital Information Management System) systems and all
medical devices that can transfer data at the patient's location. The system constantly receives up-to-date patient data from
these devices. It ensures that all paper forms in the patient location are transferred to digital media via tablet computers.

Operation History, Dose Period, Fluid Period, Bolus and method-based drug administration records can be monitored
on the system. Anesthesia Drug set definition and application processes, event - discovery - observation - intervention
follow-ups, ventilator set identification and applications and the entire operation process are recorded instantly in the
digital environment. Thanks to the step-by-step registration entry infrastructure, mandatory forms such as secure
surgical forms and anesthesia follow-up forms are easily recorded in the digital environment.

All parameters and events are recorded in the correct order by adding time stamps on the integrated devices. If the
patient leaves the operating room with the devices connected to the system, this information is also stored in the
system. With the HIMS integration, patient demographic information is obtained and the patient's current
laboratory data can be displayed graphically and numerically.

Thanks to the clinical photographing feature, active process-based records can be tagged, notes can be added to
these tags, and relevant users can comment on these notes.

www.denizlermedikal.com




Dijital Yogun Bakim
Bilgi YOonetim Sistemi

Digital Intensive Care
Information Management System

Discover
the potential
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Yogun Bakim Bilgi Yénetim Sistemi (YBBYS), hastanelerin yogun bakim tnitelerinde (YBU) takip ve tedavileri stirdiiriilen
hastalara ait tibbi stireclerin elektronik ortamda kayit altina alinmasini, hastaya ait verilere (kan grubu, yas, cinsiyet, hasta
yakinlari, yer ve kalis stresi) erisim saglamayi, tedavi streclerinin sistem Uzerinden planlanmasini, tibbi parametrelerin
takibini, yogun bakima &zel tibbi skorlamalarin (Glaskow Koma Skalasi - GKS, Apache Il, SOFA, SAPS, Sedasyon vb.)
hesaplanmasini ve sonuclarla ilgili bildiim yapilmasini, raporlama ve kalite &lcim araglarinin  olusturulmasini
amaclamaktadir. Yogun Bakim Bilgi Yonetim Sistemi web tabanli bir sistem olmakla birlikte Hastane Bilgi Yonetim
Sistemi'ne ve hastanin bulundugu yerde veri aktarabilen tUm cihazlarla entegre olarak calismaktadir. Sistem cihazlardan
sirekli sekilde glncel hasta verilerini almaktadir. Hasta lokasyonunda bulunan tim kagit formlarin  tablet
bilgisayarlar Uzerinden dijital ortama aktarilmasini saglamaktadir.

Yogun bakim saglik personelinin vardiya degisikliklerinde hastalarini birbirine transfer etmesine, aktif order ekraninda
sorumlu doktorlar tarafindan verilen emirleri takip etmesine ve bu emirleri dogru zamanda kolayca uygulamasina
olanak tanrr.

Sistemin order seti agiklama menUstnden rutin uygulamalar, beslenme, aktivite-bakim tibbi ve laboratuvar gibi ilgili tim
order tUrlerini set olarak kaydedilebilmektedir. Apache 2, Sofa veya Glasgow gibi grafiksel ve sayisal gorsel altyapilar
ile hesaplanabilmekte ve ekran izlenebilmektedir.

Kullanicr dostu raporlama menisU sayesinde dijital ortamda anlik ve glnlik raporlara kolayca ulasilabilmektedir. Klinik
fotograflama ozelligi sayesinde aktif prosedir bazli kayitlar etiketlenebilmekte, bu etiketlere notlar eklenebilmektedir.

The Intensive Care Information Management System (YBBYS) enables the electronic recording of the medical process-
es of the patients who are followed up and treated in the intensive care units (ICUs) of the hospitals, accessing the data
of the patient (blood type, age, gender, patient relatives, location and length of stay). It aims to provide treatment
processes through the system, to monitor medical parameters, to calculate intensive care-specific medical scores
(Glaskow Coma Scale - GKS, Apache I, SOFA, SAPS, Sedation, etc.) and to report the results, to create reporting and
quality measurement tools. Although the Intensive Care Information Management System is a web-based system, it
works in integration with the Hospital Information Management System and all devices that can transfer data at the
patient's location. The system constantly receives up-to-date patient data from the devices. It ensures that all
paper forms in the patient location are transferred to digital media via tablet computers.

It allows intensive care healthcare personnel to transfer their patients to each other during shift changes, to follow the
orders given by the doctors in charge on the active order screen, and to easily implement these orders at the right
time.

From the order set explanation menu of the system, all related order types such as routine applications, nutrition, activi-
ty-care medicine and laboratory can be saved as a set. It can be calculating and the screen can be viewed with
graphical and digital visual infrastructures such as Apache 2, Sofa or Glasgow.

Thanks to the user-friendly reporting menu, instant and daily reports can be easily accessed in the digital environment.

Thanks to the clinical photographing feature, active procedure-based records can be tagged and notes can be added
to these tags.
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